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Preliminary notes

Hardware: OPUS_A3/A6_Hardware_Manual_V1.0 

Software: Operating System: OPUS_A3_C_CPP_Developer_Guide

OPUS update manual

Projektor-Tool: HTML Help 

CODESYS: Codesys_Operator_Manual

Operators must read these installation instructions, particularly the safety information, and must be familiar with the 

operation of the equipment. 

The following topics among others can be found in the above hardware and software documents : Used Instructions 

Types, Safety instructions, guarantee and liability, Intended Use, Getting Started and Technical Documentation 
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Legal notes

All operating manuals and products names cited in the operating Trademarks manual are registered trademarks of  Topcon 

Electronics GmbH & Co KG All rights reserved, including translation.

No part of this operating manual may be reproduced, in any form, (print, photocopy, microfilm, or a different process), nor 

may it be processed, duplicated, or distributed using electronic systems, without written permission from Topcon 

Electronics GmbH & Co KG, Geisenheim.

All previous versions are rendered obsolete with publication of New manuals. All information contained herein is subject to 

correction, manufacturer is not liable for any errors in this presentation 
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1. Introduction – About me

516.01.2023

- Dipl.-Ing. Electrical Engineer

- Over 12 years experience for Wachendorff Elektronik / Topcon Electronics

- Main work areas:

- Customer support via phone / email

- Trainings and workshops

- Creation and maintenance of trade show / example projects 

- Technical documentation
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1. Introduction – Training targets

Training targets:

• Understanding the project design concept of CODESYS*

• Learning about our Driver structure to access device functionality

• Being able to configure the CAN protocol you need

*Controller Development System
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2. Updating your device – The developer cable

816.01.2023

What are all those clamps on the developer cable?! cable color 

A/DI 1 – 4 – Analog / Digital Inputs brown,green,yellow,grey

DO 1 – 3 – Digital Outputs white,lilac,blue

RS232 – serial console of the Linux system RxD-red-blue,TxD-red,GND-pink

CAN1/2 – CAN ports CAN1-pink(high),blue(low)

CAN2-green(high),yellow(low)

USB – USB VCC-red,GND-black,Low-white,High-green

Clamp 30 – Battery plus red

Clamp 15 – Ignition (Should be connected into Clamp 30) red-blue

GND / Car GND – Ground (Should be connected if separate clamps)* GND-black,CarGND-white, black connector(s)

Serv_EN – Service Enable black
*Not for B series! There pin4 is WakeUp
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2. Updating your device

When you purchase new devices, always perform a software update first!

All software elements should be on the same level as released from us:

CODESYS IDE on your PC

Operating System (OS) on the device

CODESYS runtime on the device



Service image
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2. Updating your device – The update files

The update packet for your device (under \CustomerFiles\Device\OPUSAx\) consists of:

A3 / A6 G1 A6 G2 / A8

OS – Operating System. A customized embedded Linux system.

Service files to update from OS 1

Codesys Runtime – The application that displays your project on the device.

Boot logo – The image that is displayed when the device is started -> created by the customer (see chapter 7)

Boot loader

Root file system

Power management

firmware
Linux kernel

Service project is an 

extra application
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2. Updating your device – Preparations

1. Power off the device

2. Put all 12 update files in the root 

folder of a FAT32 formatted USB stick 

and connect it with the device

3. Connect the USB stick with the device

4. Power up the device in service mode by

a) Connecting clamp service enable OR

b) Pressing the left keys 1 + 2 

(hold for 3 seconds)

-> for A8, press Key 1 + Stop

4 a)

4 b)
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2. Updating your device – Almost done

When you see this screen (or similar), 

let go of the keys or disconnect the clamp 

service enable

The update takes 3-5 minutes after which 

the device will restart and, after the touch 

screen calibration, if you have a touch 

screen device, show the service project.
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3. Getting to know the CODESYS IDE – Installation

Install the CODESYS IDE with administrator 

rights

Click through the steps in the installation –

usually no settings have to be changed

If you have another Codesys installed, 

choose a different installation location

Start Codesys after the installation
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3. Getting to know the CODESYS IDE – Installation

In Codesys, select the menu

Tools -> Package Manager…

In the dialog, click Install…

and browse to \CustomerFiles\PC

in your Codesys package

Install the TE_________.package
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3. Getting to know the CODESYS IDE – Program overview

Object properties / devic tree (application) / POU(program organisation units)

Menu bar
Tool bars

Main window

Build messages / errors

Object Toolbox
Device tree

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg
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3. Getting to know the CODESYS IDE – Program overview

5 programming languages for application programming (IEC 61131-3) are available:

• IL (Instruction list) an assembler like programming language

• ST (Structured text) similar to programming in PASCAL or C

• LD (Ladder diagram) enables the programmer to virtually combine relay contacts and coils

• FBD (Function block diagram) enables the user to rapidly program both Boolean and analogue expressions

• SFC (Sequential function chart) convenient for programming sequential processes and flows

We will focus on ST code

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg
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4. The first project

1. Create a new project

2. Configuration

3. The first program

4. The first visualisation

5. Driver module 
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4.1 The first project – Create a new project

To create a new project, 

click on File -> New Project…

press the New Project icon 

or press CTRL + N

Select Standard project, choose a project 

name and location click OK
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4.1 The first project – Create a new project

Select the matching device description and 

choose Structured Text (ST) as the default 

programming language

The most basic project

- one device

- one application

- one program (PLC_PRG)

- one task (MainTask)

- Driver module (for device specific functions)
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4.2 The first project – Configuration – Network configuration

Go to the network adapter settings of your 

PC and change the settings for IPv4

The computer IP has to be in the same 

subnet as the displays

Standard IP addresses for the displays (can 

be changed):

192.168.135.6

Now connect the running device with your 

PC over Ethernet
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4.2 The first project – Configuration – Device connection

Go to the menu Tools -> Options…

Go to the category Device editor

Make the settings according to the screenshot
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4.2 The first project – Configuration – Device connection

Double click on Device

Click on Add gateway…

Click OK

Or select the existing Gateway
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4.2 The first project – Configuration – Device connection

Select the gateway and click on Scan 

network

If the device isn’t found, set the Filter to 

None
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4.2 The first project – Configuration – Device connection

Double click on the device in the list or 

select it and click on Set active path to 

connect to the device



2716.01.2023

4.4 The first project – The first visualization

Right-click on Application and choose Add 

Object -> Visualization…

Click Add in the dialog (no settings 

necessary)
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4.4 The first project – The first visualization

We just added a Visualization element

CODESYS adds some components 

automatically:

- VISU_TASK in the Task Configuration

- Visualization Manager

- TargetVisualization in the Visualization 

Manager
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4.3 The first project – The first program

Double click the program PLC_PRG and 

write the variable declaration and code 

according to the screenshot
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4.3 The first project – The first program – Building the code

Compile the project by clicking in the menu 

Build -> Build or by pressing F11

Message box should show the message 

Compile complete – 0 errors, 0 warnings

Our first program built successfully, big applause
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4.3 The first project – The first program – The first download

Download the project with Login in the 

menu Online (or by pressing Alt+F8) or 

press the         icon in the tool bar

Press Yes to download the application to 

the display

Press OK to overwrite the service project
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4.3 The first project – The first program – The first download

Start the project with Start in the 

menu Debug or by pressing F5 or clicking 

the       icon in the toolbar

-> empty visualization (white screen)

->you can see the counter rising on the PC

-you can manipulate the value in the 

column prepared value

-send the value with CTRL + F7

-log out of the device with CTRL + F8 or by 

clicking       in the toolbar to 

continue working on the project
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4.4 The first project – The first visualization – Settings

Make the settings according to the 

screenshots

Visualization Manager:

- Use unicode strings

- Use CurrentVisu variable

These are general recommendations for projects
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4.4 The first project – The first visualization – Rectangle

Click on Rectangle in the toolbox and draw 

a rectangle in the visualization or drag & 

drop it from the toolbox into the 

visualization

Select the rectangle and add Counter: %s

into Texts -> Text

or by double-clicking the rectangle

Add the variable PLC_PRG.i into 

Text variables -> Text Variable

Log in again to update the application on 

the device, then start the application (F5)

Log out afterwards to continue working
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4.4 The first project – The first visualization – Rectangle
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4.5 The first project – Tasks and timings

Add a second rectangle

Add the expression

PLC_PRG.i MOD 2 = 0

to the 

Color Variables -> Toggle color property

Download and start the application

Please note the flashing screen.
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4.5 The first project – Tasks and timings

Add a second rectangle

Add the expression

PLC_PRG.i MOD 2 = 0

to the 

Color Variables -> Toggle color property

Download and start the application

Please note the flashing screen.

Double-click on the MainTask and on the 

VISU_TASK

Change the interval of the MainTask from 

20 ms to 25 ms and download again
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4.5 The first project – Tasks and timings

-> Take care of your timings!

0 20 40 60 80 100 120 140 160 180 200 220 240 260 280 300

0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1

0 1 0 1

0 25 50 75 100 125 150 175 200 225 250 275 300 325 350 375

0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1

0 0 0 0

Time (ms)

MainTask (20 ms)

VISU_TASK(100 ms)

Time (ms)

MainTask (25 ms)

VISU_TASK(100 ms)

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg
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4.6 The first project – Fit the screen

To know how big your screen is in the editor

make the settings according to the 

screenshot

-> Then change the scaling back to Fixed

OPUS A3: 480 x 272

OPUS A6 G1 /G2: 800 x 480

OPUS A8: 1280 x 800
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Change to the POU tab

Right-click and select

Add Object -> Image Pool…

Double-click the ImagePool to open it

4.7 The first project – Images – Static images
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Write the ID bg_training1

Select the image 

Training_Background_1.png from the 

training pictures folder

4.7 The first project – Images – Static images
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Click on Image and draw an image 

or drag & drop an image into the visu

In the image selection dialog select the 

image bg_training1 and click OK

4.7 The first project – Images – Static images
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the ID is set in the Static ID property

Set the size and position properties

Right-click the image and select

Order -> Send to Back

Delete the two rectangles

4.7 The first project – Images – Static images
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Put the images BUTTON_PLUS_X.png and 

BUTTON_MINUS_X.png in the global 

image pool

Create another image object

Choose the “plus” image in the dialog

Initialize a string variable in PLC_PRG

Set the Bitmap ID Variable to this string 

variable

Transfer the project and set the variable on 

the PC (from ‘plus’ to ‘minus’)

4.7 The first project – Images – Dynamic images
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Create another visualization

(right-click on Application -> Add Object -> Visu)

Create a button from the Toolbox -> 

Common Controls in the first visualization

Configure the button to change to this 

visualization

Add the image Training_Background_2.png 

to the Global Image Pool

Create an image in the new visu and use 

the image as a background

Start visualization? Set it in 

TargetVisualization

4.8 The first project – Buttons and navigation – A second visualization
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In the new visualization, create a button 

(push switch, dip switch etc.)

Also create a Lamp object and in PLC_PRG

a variable button_switch (bool) and 

connect it with the button and the LED

Test the behavior

You can change from Toggle to Tap in the 

property Element behavior of the button 

object

Add the same functionality for a soft key

4.8 The first project – Buttons and navigation – Push button or toggle
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On the new visualization, create an image 

with these settings

Put the images BUTTON_BACK.png and 

BUTTON_BACK_X.png in the global image 

pool

In the PLC_PRG, create a variable 

button_back

Configure the events for the “button”

4.8 The first project – Buttons and navigation – Button with 2 images



5. CAN communication
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1. Basic settings

2. Terminal and Owner ECU configuration

3. Creating messages

4. Background information



5.1a CAN communication
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5.1a CAN communication – Set up the CAN bus
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Right click on Device, click on Add 

Device…, select 3S company as vendor

Select CANbus, edit the name if 

wanted

Press on Add Device



5.2a CAN communication – Add local device
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Click on CANbus in the device tree, the 

dialog will change

Choose CANopen Device, version 3.5.8.0, 

click Add Device and close the dialog



5.2a CAN communication – Configuration
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Double click on CANbus

Choose the network:

0 - CAN1

1 - CAN2

Choose the desired baudrate

Double click on CAN_Local_Device

Choose the node ID



5.3a CAN communication – Add I/O areas
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Click on Edit I/O area… to add the PDO 

communication variables

Click on Add area…



5.3a CAN communication – Add I/O areas

54

CODESYS always uses the viewpoint of the Master!

Input

Output

http://upload.wikimedia.org/wikipedia/commons/5/59/Info_blue.svg


5.3a CAN communication – Add I/O areas
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Add 2 INT Input variables for Transmit PDO 

(the OPUS sends these)

Click again and add 2 INT variables as 

output (the OPUS receives these)

Click on OK to close the dialog



5.3a CAN communication – Add variables
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Create a global variable list (leave the name 

GVL)

Add the following variable declarations

Write the following program into the 

PLC_PRG 



5.3a CAN communication – Add variables

5716.01.2023

Double click on CAN_Local_Device

Switch to the tab CANbus Slave I/O 

Mapping

Map the declared variables to the CAN 

Input & Output:

Digital_Outputs1:

RPDO1 variables

Digital_Inputs1:

TPDO1 variables



5.3a CAN communication – Create Visu
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Create a meter, a bargraph and a slider 

object

Set the variable / value property to:

- TPDO1_Byte5_8 for the slider

- RPDO1_Byte1_4 for the meter

- RPDO1_Byte5_8 for the bargraph

Test the communication

-> no communication?

Send a message with

ID 0x000

DLC 2

Data 01 00

first to set the OPUS to operational mode



5.3a CAN communication – Sending cyclically
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Set the Event Timer to a value > 0 to enable 

cyclic sending

-> Value has to be a multiple of the main 

task

Also you can change the COB ID (not 

CANopen conform!) by changing the value 

in COBID

Continue with chapter 6



5.1b CAN communication
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5.1b CAN communication – Add CAN interface
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Right click on Device, click on Add 

Device…, select 3S company as vendor

Select CANbus in selection, edit the name if 

wanted

Press on Add Device



5.2b CAN communication – Add J1939 manager
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Click on CANbus in the device tree, the 

dialog will change

Choose J1939_Manager and click Add 

Device



5.2b CAN communication – Add J1939 ECU
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Click on J1939_Manager in the device tree, the 

dialog will change

Choose J1939_ECU, click on Add Device and 

then Close



5.3b CAN communication – Configuration
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Doubleclick on CANbus

Choose the network:

0 - CAN1

1 - CAN2

Choose the baudrate (250 kbit/s is standard 

for J1939)

Doubleclick on J1939 ECU

Choose the preferred address

-> These are the settings for the J1939 ECU



5.3b CAN communication – Creating messages
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Doubleclick on J1939_ECU

Go to the tab TX Signals, click on Add PG

Choose PGN 61444 and click Add PG to 

close the dialog



5.3b CAN communication – Creating messages
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Create a Global Variable List by

right-clicking Application -> Add Object -> 

Global Variable List…

Name it J1939

Click Add to close the dialog

Open the GVL J1939 and create these 

variables



5.3b CAN communication – Creating messages
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In J1939_ECU Common J1939 I/O Mapping, 

map the variable 

Application.J1939.Engine_Speed

to Engine_Speed

In the PLC_PRG, write this line



5.3b CAN communication – Creating messages
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Create a meter, a bargraph and a slider 

object

Connect the objects with the variables as 

shown



5.3b CAN communication – Sending PGNs
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The previous J1939 configuration is only for 

receiving

To send, add another J1939_ECU, 

double-click it and check Local Device

-> This device is only for sending!



5.3b CAN communication – Sending PGNs
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Add a PG and use PG 0



5.3b CAN communication – Sending PGNs
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Map the variable 

Application.J1939.

Engine_Requested_Speed_Speed_Limit

Download and test

Change the value with the slider



5.3b CAN communication – Sending cyclically

72

Make the settings according to the 

screenshot

The default sending frequency is derived 

from the task with the lowest interval

Change it by setting the CycleTimeFactor

Example: 

Main task runs with 50 ms; 

CycleTimeFactor 3

-> PGN is sent every 150 ms



5.3b CAN communication – Custom PGNs

73

If a custom PGN message is needed, add a 

PG and switch to the Custom tab to make 

the necessary settings

Continue with chapter 6



5.1c CAN communication
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5.1c CAN communication – Setup
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First, we need one or both of these modules in 

the Driver Tree

Config0 -> First CAN port

Config1 -> Second CAN port



5.1c CAN communication – Setup

7616.01.2023

Add ReceiveMessage modules and 

TransmitMessage modules as needed for each 

CAN port used

One Module for each Mapping / CAN ID



5.1c CAN communication – Setup
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The CAN Layer 2 module needs to be activated

at the start of the project, so put this code in a 

startup sequence



5.1c CAN communication – Receive messages
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The setup of a message can be done in the table

(Double-click on the message in the tree)

or in code

Important settings:

- COBID – The CAN ID of the message 

(in the example: 0x123)

- DLC – The length of the data (0 to 8 byte)

- x29bit – True if 29bit ID’s are used, 

False if 11bit ID’s are used

The same settings in code



5.1c CAN communication – Receive messages - The data
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The data for a receive mapping can be 

processed like this

Declaration

Code



5.1c CAN communication – Receive messages - Important
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What’s important to know:

There is no automatic processing of the 

messages, getting the data must be done in 

code in a timely manner



5.1c CAN communication – Transmit messages
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The setup of a message can be done in the table

(Double-click on the message in the tree)

or in code

Important settings:

- COBID – The CAN ID of the message 

(in the example: 0x123)

- DLC – The length of the data (0 to 8 byte)

- Transmit Trigger – When/how should

the message be sent (see next slide)

- x29bit – True if 29bit ID’s are used, 

False if 11bit ID’s are used

The same settings in code



5.1c CAN communication – Transmit trigger
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Transmit trigger can be:

0 – none (mapping inactive)

1 – timerBased (Timeout needs to be set)

2 – onValueChange (any value in the mapping 

changes)

3 – a combination of 1 and 2

Example in code for a cyclic transmit message 

every 100 ms



Agenda

8316.01.2023

1. Introduction

2. Updating your device

3. Getting to know the CODESYS IDE

4. First project

5. CAN communication

6. Extended agenda

7. FAQ



6. Extended agenda
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1. ARM library

2. Backup / USB project loading

3. PDF Reader

4. Power management

5. Retain variables

6. Date and time

7. Languages

8. Data logging / USB file transfer

9. Alarms



6.1. Extended agenda – Wachendorff ARM library
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Device structure for everything specific to 

OPUS devices:

- Inputs/Outputs

- Backlight

- Beeper

- Power management

- EEPROM

- Device configurations

The elements are explained in our help file



6.1. Extended agenda – Wachendorff ARM library
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Example: Display Backlight

Usage in code:

DisplayBacklight.Brightness := 255;



6.2. Backup / USB project loading
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To install the project to devices with a USB 

stick, a backup from a connected device is 

needed

Install these devices

First set the mode of the backup

Then set the Trigger to true

USB stick needs to be inserted

Runtime files -> user____.tar.gz

Project files -> Update at runtime with 

Update Daemon



6.4. Extended agenda – Power management
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15
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A3 A6 A6G2 A8

430 900 1000 1600

mA @13.5 V

On



6.4. Extended agenda – Power management
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CL

15

On

CL

15

Low

Power



6.4. Extended agenda – Power management
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CL

15

On

CL

15

Low

Power

Codesys, CAN are working

☐/☑ Display function ☐/☑ Multicolor LED 

☐/☑ Display backlight ☐/☑ Beeper / Speaker

☐/☑ Key backlight ☐/☑ Touchscreen

☐/☑ Key function ☐/☑ Console (RS232)

☐/☑ Encoder function ☐/☑ Video processing

☐/☑ Outputs ☐/☑ Camera output

Driver->Daemon->PMD->_________) 



6.4. Extended agenda – Power management

9316.01.2023

CL

15

On

CL

15

Low

Power

Codesys, CAN are working

☐/☑ Display function ☐/☑ Multicolor LED 

☐/☑ Display backlight ☐/☑ Beeper / Speaker

☐/☑ Key backlight ☐/☑ Touchscreen

☐/☑ Key function ☐/☑ Console (RS232)

☐/☑ Encoder function ☐/☑ Video processing

☐/☑ Outputs ☐/☑ Camera output

A3 A6 A6G2 A8

430 900 1000 1600

160 200 200 300

mA @13.5 V
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Low Power*

*With minimal configuration Driver->Daemon->PDM->_________) 



6.4. Extended agenda – Power management
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CL

15

On

CL

15

Low

Power

0 – 2332800 seconds

PMD.LowPowerTimeout) 



6.4. Extended agenda – Power management
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Power
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(PMD.LowPowerTimeout) 



6.4. Extended agenda – Power management
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Low

Power
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Nothing is working, no functionality!

(PMD.LowPowerTimeout) 



6.4. Extended agenda – Power management
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(PMD.LowPowerTimeout) 



6.4. Extended agenda – Power management
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CL
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Power
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PMD.SleepTimeout)

(PMD.LowPowerTimeout) 



6.4. Extended agenda – Power management
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6.4. Extended agenda – Power management

10016.01.2023

CL

15

On

CL

15

Low

Power
Sleep

A3 A6 A6G2 A8

430 900 1000 1600

160 200 200 300

≤ 90 ≤ 100 ≤ 100 ≤ 200

<3 <3 <3 <3

mA @13.5 V

On

Low Power

Sleep

Off

Off

(PMD.LowPowerTimeout) (PMD.SleepTimeout) 



6.4. Extended agenda – Power management
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6.5. Retain variables
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If variables should survive a shutdown or 

restart, declare them as retain in a Global 

Variable List.



6.5. Retain variables

108

For persistent variables you need to create 

a specific persistent variable list.



6.5. Retain variables
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Retain and persistent retain variables are 

only saved when the device is shutting 

down 

To save at runtime, include this code in 

your project (e.g. when leaving a settings 

page)

The processing takes a second, so don’t do 

it too often (not cyclic)

VAR

result:RTS_IEC_RESULT;

retname:STRING;

pApp:POINTER TO cmpapp.APPLICATION;

END_VAR

pApp := cmpapp.AppGetCurrent(ADR(result));

retname := concat(pApp^.szName,'.ret');

result := cmpapp.AppStoreRetainsInFile(pApp, retname);

TDS.SystemCall('sync');



6.6. Date and time
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Showing the date and time from the RTC is 

very easy (in 24h format)

If you need the values (e.g. for writing),

add these devices

Values can be read and written in code

(not in Visus directly)

-> AM/PM? See chapter “Text and

Language in Visualization“ in the

online help



6.7. Languages – static

111

Every String used in the project can be 

found in the GlobalTextList

There you can add a new language and fill 

the texts for each language

Export/Import is also possible (for 

translators)



6.7. Languages – dynamic
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For dynamic texts you need to create a text 

list

Add languages just like for static text

Connect the object with the text list

Switch languages with the variable 

CurrentLanguage (library VisuElemBase)



6.8. – Data logging / USB file transfer

113

Please check the example project

USB_File_Operations



6.9. – Alarms
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To create alarms, first add an Alarm 

Configuration

Rename if needed and click Add

A structure with 3 alarm levels is created

The AlarmStorage is for archiving the 

alarms that occur(ed) on the device



6.9. – Alarms
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Add an alarm group and give it a name of 

your choice

In the alarm group the actual alarm events 

(observations) will be configured

The event in the alarm group will trigger 

the action defined in the alarm level



6.9. – Alarms
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Create an alarm table on a visu

The alarm table will display a history of the 

occurred alarms

You can also create an Alarm banner to 

quickly see the last / most important alarm



6.9. – Alarms
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Create these variables and the code below

Use ack in the 

Acknowledge all property of the table



6.9. – Alarms

118

In the Alarm Group, create 3 observations



6.9. – Alarms

119

Configure the alarm levels



6.9. – Alarms
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Configure the alarm levels

Then test the alarms by changing the 

counter variable 



Agenda

12116.01.2023

1. Introduction

2. Updating your device

3. Getting to know the CODESYS IDE

4. First project

5. CAN communication

6. Extended agenda

7. FAQ



7 – FAQ

12216.01.2023

1. How can I use different fonts in my project?

2. How can I change the boot logo?

3. How can I display a camera image

4. How can I use the Codesys Web Visu?



7.1 – FAQ – How can I use different fonts in my project?

12316.01.2023

Fonts need to be installed in Windows so 

they can be chosen in Codesys

But the also need to be on the device.

Load them into the project with Device -> 

Add Object -> External File…



7.2 – FAQ – Connect to the serial console

12416.01.2023

To connect to the serial console of the 

device, use a program like HyperTerminal, 

PuTTY or TeraTerm.

Use the following settings to connect 

(COM port can differ depending 

on your configuration)



7.2 – FAQ – Connect to the serial console

12516.01.2023

To log in, use 

username root

password “opusa3” or “opusa6”



7.2 – FAQ – Change the boot logo

12616.01.2023

Put the image (png file, 

resolution 480x272 for A3, 

800 x 480 for A6) on a USB stick and 

connect it to the device.

Use the command 

“setbootlogo imagepath” 

to change the boot logo of the device



7.2 – FAQ – Change the update boot logo

12716.01.2023

To change the boot logo for the 

update process, you need to create a 

checksum file.

Rename the image to “logo.png”, 

put it on a USB stick and connect it 

to the device.

Use the command 

“md5sum logo.png > logo.png.md5” 

to create the md5 checksum file.



7.3 – FAQ – How can I display a camera image? 

12816.01.2023

First you need to add a VideoObject to the 

Driver module

Double click it and make the necessary 

settings (especially the Channel)

VideoObject0 is for camera inputs

1 and 3

VideoObject1 is for camera input 2

VideoObject0 Channel 0 -> camera input 1

VideoObject0 Channel 1 -> camera input 3

VideoObject1 Channel 0 -> camera input 2



7.3 – FAQ – How can I display a camera image? 

12916.01.2023

Now select the VideoObject in the ToolBox, 

in the category TDS and draw a rectangle in 

the visu window

The object is a frame of the type video 

object



7.3 – FAQ – How can I display a camera image? 

13016.01.2023

In the properties of the VideoObject frame, 

set References -> TargetContainer -> data

to the name of the VideoObject you 

created

Resize the frame to a 4:3 size ratio for a 

correct video image
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16
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7.4 – FAQ – How can I use the Codesys Web Visu? 

131

To add a Web Visu, right-click on the 

Visualization Manager, then Add Object, then

WebVisu…

Give it a name of your choice and click Add in 

the dialog



7.4 – FAQ – How can I use the Codesys Web Visu? 

132

Open the WebVisualization to configure the web 

visu

For a mirror functionality use the same visu as in 

the target visualization

If you want to have a different visu for the web 

visu, enter a specific visualization in “Start 

Visualization:”

Name of the visu that is shown 

as the first web visu

Name of the web visu html file



7.4 – FAQ – How can I use the Codesys Web Visu? 

133

To keep objects from being used in the web 

visu, use the property Deactivate inputs

for each input object

Visuelems.CurrentClientType determines where 

the visu is running:

-Device (target): Visuelems.CurrentClientType=4

-PC Codesys: Visuelems.CurrentClientType=1

-Webvisu: Visuelems.CurrentClientType=8



7.4 – FAQ – How can I use the Codesys Web Visu? 

134

To access the web visu, you need to be in the 

same network as the device, or create a VPN.

The call in the browser has to be done like this:

<IP_of_device>:8080/<web visu name>

e.g.

192.168.135.6:8080/webvisu.htm


